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Introduction 

PHD2 is the "second generation" of Craig Stark's original PHD application.  PHD has become a fixture 

of the amateur astronomy community with more than a quarter million downloads.  From its inception, it 

has successfully embraced three seemingly conflicting objectives:  

1. For the beginning or casual imager, to deliver ease of use and good guiding performance "out of 

the box"  

2. For the experienced imager, to deliver sophisticated guiding algorithms, great "tunability", and 

broad support for imaging equipment  

3. For all users, to consistently exhibit a commercial level of quality while being available free of 

charge 

In order to extend PHD to more platforms and further expand its capabilities, Craig released his program 

to the open-source community, and PHD2 is the direct result of that generosity.  It has been substantially 

restructured to make it more extensible and supportable going forward.  Moreover, the initial release of 

PHD2 already includes a substantial number of new features and refinements while retaining all the core 

strengths of the original.  Users of the new PHD2 can be confident it will remain committed to the three 

objectives that made the original application so successful.      
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Main Screen 

The PHD2 main window is designed for ease of use and clarity.  Its intent is to support a quick and 

natural sequence of interactions to start and control guiding.  The basic steps for doing this are as 

follows: 

1. Connect to your guide camera and mount 

2. Start a sequence of guide exposures to see what stars are available in the field of view 

3. Choose a guide star and calibrate the guider 

4. Continue guiding on the target star while using various display tools to see how things are going 

5. Stop and resume guiding as necessary 

 

The majority of the screen is taken up by the display of the star field from your guide camera.  The 

display is automatically adjusted for size, brightness, and contrast so you can have a clear view of 
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available stars.  However, these adjustments are done only for display purposes.  Internally, PHD2 

operates on the raw, un-adjusted data in order to maximize guiding accuracy.  This display is also used 

to select a guide star by simply clicking on it. 

Basic control 

Near the bottom of the screen are the main controls.  PHD2 is largely controlled by these buttons and 

sliders, with additional pull-down menus at the top of the window for more detailed functions.  Moving 

from left to right in the window, the primary buttons are as follows:  

1. The camera icon - used to connect to your camera and mount devices 

2. The loop icon - used to start a sequence of repeated exposures with the guide camera ("looping"), 

with each resultant image (guide frame) being displayed in the main window.  If guiding is 

subsequently started, clicking on the 'loop' icon again will pause guiding while continuing to take 

guide exposures. 

3. The guide/target icon - used to start calibration, if needed, and then to start guiding on the 

selected star.   

4. The stop icon - used to stop both guiding and looping  

To the right of the stop icon is a pull-down list of exposure durations (0.01s - 15s).  You use this control 

to quickly set the guide camera's exposure duration.  If your camera does not support an exposure 

duration, PHD2 will do its best to emulate that duration.  For example, if you use a short-exposure 

webcam, your maximum true exposure duration might be only 1/30th of a second.  If you select one 

second as the desired exposure time, PHD2 will automatically acquire images for one second and stack 

them on the fly to create a composite image for guiding.  

The next control to the right is a slider for adjusting screen stretch and contrast, essentially a "gamma" 
adjustment.  PHD2 automatically adjusts the display accounting for the darkest and brightest pixels in 

the image, and the slider is used to fine-tune the display to better see the stars in the field of view.  This 

may be useful, for example, if you are trying to focus the guide camera for the first time and need to see 

the large, out-of-focus star image. Moving the gamma slider only makes the display brighter or dimmer 

for your viewing. PHD2 always uses the raw pixels from the camera for guiding, and moving the 

gamma slider has no effect on guiding.  A display of "completely white" or "completely black" is 

usually an indication that no stars are available in the field of view. 

Next to the gamma slider is the so-called "brain button."  This button brings up an Advanced Dialog for 

making detailed adjustments to PHD2's guiding operations.  A major design goal of the program is to 

minimize your need to change these parameters, but "the brain" is nothing to be feared - there are 

adjustments available here that can significantly improve your experience.  Over a period of time, you 

should take a look at this dialog and learn what it can do for you.  

The rightmost control in this row is a "camera dialog" button.  This may be disabled ("grayed out") 

depending on the type of guide camera you have selected.  If it is enabled, you can click on it to set 

various parameters that are unique to that type of camera - binning and specialized gain settings are 

examples of such parameters, but there could be others depending on the camera.  

Menus 

http://openphdguiding.org/man-dev/Advanced_settings.htm
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The pull-down menus above the main guider display are used to access a variety of functions.  These are 

described in the Darks, Tools and Utilities, and Visualization sections of this help document.  

Status Bar 

The status bar at the bottom of the main window is used to display messages and status information that 

will help you keep track of guiding operations.  For example, the rightmost three panels on the status bar 

will show you whether the camera and mount are connected and whether the guider has been 

successfully calibrated.    

 

 

Using PHD2 Guiding 
There are five basic steps to start guiding.  

1. Press the camera button and connect to your guide camera and mount. 

2. Pick an exposure duration from the drop-down list. 

3. Hit the loop button and look at the available stars, adjusting focus if necessary. Move the mount 

or adjust the exposure duration as needed to find a suitable guide star. 

4. Click on a non-saturated star that's not very near an edge for use as the guide star. 

5. Press the PHD2 Guide button. 

Details of these operations will be described in the sections below. 

 Equipment Connection 

 Exposure Time and Star Selection 

 Calibration 
 Guiding 

Equipment Connection 

In order to begin guiding, PHD2 must first connect to your hardware: the guide camera, the mount, and, 

optionally, an 'aux' mount, an adaptive optics (AO) device, or a rotator.  When you click on the camera 

icon, you'll see a dialog that looks like this:  

 

 

http://openphdguiding.org/man-dev/Darks_BadPixel_Maps.htm
http://openphdguiding.org/man-dev/Tools.htm
http://openphdguiding.org/man-dev/Visualization.htm
http://openphdguiding.org/man-dev/Basic_use.htm#Equipment_Connection
http://openphdguiding.org/man-dev/Basic_use.htm#Exposure_Time_and_Star_Selection
http://openphdguiding.org/man-dev/Basic_use.htm#Automatic_Calibration
http://openphdguiding.org/man-dev/Basic_use.htm#Guiding
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Camera Selection 

The Camera drop-down list shows all the camera types currently supported by PHD2.  With the 

exception of ASCOM-compatible cameras, the camera drivers are bundled with  PHD2  and will reside 

on your system after the PHD2 installation.  ASCOM-compatible camera drivers are available from the 

ASCOM web site or from the camera manufacturer, and the drop-down list will show only those 

ASCOM cameras that are already installed on your system, if any. 

 

The list of supported cameras at the time of writing is shown below - but users should consult web 

resources to see updates (e.g. Stark Labs) 

 

Supported cameras, December 2014: 

 

Windows: 

 ASCOM v5/6 compliant cameras 

 Atik 16 series, color or monochrome 

 Atik Gen 3 color or monochrome 

 CCD-Labs Q-Guider 

 Fishcamp Starfish 

 iNova PLC-M 

 MagZero MZ-5 

 Meade DSI series: I-III, color and monochrome 

 Orion StarShoot DSCI  

 Orion Starshoot Autoguider 

 Orion Starshoot Planetary Imager and Autoguider 

 QHY 5-II 

 QHY 5L-II 

 SAC4-2 

 SBIG 

 SBIG rotator 

 Starlight Xpress SXF / SXVF / Lodestar 

 Webcams (LXUSB, parallel, serial, OpenCV, WDM) 

 ZWO ASI 

Mac: 

 Fishcamp Starfish 

 KWIQGuider 

 Meade DSI series: I-III, color and monochrome 

 Orion Starshoot Autoguider 

 SBIG 

 Starlight XPress SXV 

 The Imaging Source (DCAM Firewire) 

 ZWO ASI 

Mount Selection 

The Mount drop-down list displays options for connecting to your mount.  There are generally two ways 

to do this: 

http://www.stark-labs.com/phdguiding.html
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1. Use an ASCOM-compatible telescope driver that sends guide commands to the mount over a 

serial cable (or more commonly,  a USB/Serial connection) 

2. Use the ST-4 compatible guide port interface on the mount with a specialized cable and an 

intermdiate device like a camera or a Shoestring box 

The ASCOM interface relies on third-party drivers to communicate with the mount.  These drivers are 

available from the ASCOM web site (ASCOM Standards) or from the mount manufacturer - they are not 

distributed with PHD2. So the drop-down list will be populated by only those ASCOM drivers you 

already have installed on your system.  The ASCOM driver must support the 'PulseGuide' interface, 

which has been a requirement for ASCOM compliance for many years and is widely supported.  With 

this type of mount control, guide commands are sent from PHD2 to the mount over the serial 

interface.  The high-level PHD2 guide commands (e.g. "Move west 500 mSec") are translated by the 

mount firmware into the appropriate motor control signals to execute the command.  With the ASCOM 

interface, PHD2 can also obtain the pointing position of the mount, especially the declination and side-

of-pier, which can be used as factors in guider calibration. 

The "Guide-port" interfaces use a specialized, hardware-level control port available on most mounts.  To 

use this type of interface, there must be another device in the link between PHD2 and the mount: 

1. Any of the guide cameras which have an ST-4 compatible "on-camera" guider interface. Use the 

'on camera' mount choice for these setups. 

2. Any of the Shoestring GP-xxx devices 

3. A supported AO device with a guide port interface 

With this style of interface,  PHD2 guide commands like "Move west 500 mSec" are translated by the 

intermediate device (camera, Shoestring box, AO) into electrical signals necessary to drive the mount 

motor for the correct length of time.   

Aux Mount Selection 

If you have selected an ST-4 style of guiding in the 'mount' section, that interface cannot be used to 

query the pointing position of the telescope.  As a consequence,  guider calibration won't be 

automatically adjusted for declination, nor will it be automatically flipped when the side-of-pier 

changes.  You can restore these features by specifying an "aux" mount connection that will be used only 

to get the telescope pointing information.  An example is shown below:  

 

 

http://www.ascom-standards.org/
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For Windows users, the "aux" mount can use any of the ASCOM-compatible mount drivers, while 

Linux users can take advantage of INDI drivers.  The "aux" mount choice will be used only if the 

primary mount interface cannot return pointing information - it will otherwise be ignored.  

Adaptive Optics and Rotator Selections 

With PHD2, you now have the option of controlling the Starlight Xpress adaptive optics unit and/or any 

of several ASCOM-compatible camera rotators  These can be specified by clicking on the 'More 

Equipment..." button in the above dialog:  

 

 
 

If you don't have these devices, just leave the selections at 'None.'  If these devices are connected, you'll 

see additional tabs in the 'Advanced Settings' dialog that provide access to various device-related 

properties.  PHD2 does not control a rotator, but it will read the current angle setting from the rotator 

and adjust the guiding calibration if needed. 

Simulators 

All of the PHD2 devices - camera, mount, AO - include built-in simulators.  You can use these 

simulators to explore how PHD2 works and to decide how you want to use the program.  There's no 

reason to waste valuable dark-sky time learning to use PHD2!  Virtually all of  PHD2's features, 

including full calibration and all the graphical display options, will work properly when device 

simulators are used.  You will even see fairly realistic guiding performance to give you some idea of 

what to expect in the field.  To get started using the simulators, choose 'Simulator' for the camera type 

and 'On-camera' for the Mount type. 

Equipment Profile 

At the top of the 'Connect Equipment' dialog are some additional controls for managing equipment 

profiles.  All of the guider settings in PHD2, default or otherwise, are automatically stored as part of an 

equipment profile.  If you have only one guiding setup - you use the same camera and guide scope 
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combination each time - you will only need one profile; and you can just use the default profile.  But 

you may have multiple equipment configurations - for example, an off-axis-guiding arrangement for a 

long focal length scope and a separate guide scope/camera configuration for s shorter focal length 

imaging scope.  The PHD2 guide settings for those configurations are likely to be different, so you 

would want to use separate equipment profiles  The controls at the top of the 'Connect Equipment' dialog 

let you choose the profile you want to use and to create/edit/remove profiles as you see fit.  When you 

select a profile and connect to its associated equipment, all of the settings last used with that profile are 

automatically reloaded.  Once you've established the profiles you need - perhaps only the default one - 

you can simply click on the 'Connect All' button and you're ready to move ahead. 

 

The recommended way to create a new profile is to use the "Wizard" capability.  The wizard takes you 

through a sequence of dialogs that explain the various settings and help you decide how to set them.  It 

will also calculate a recommended set of guiding algorithm settings that are likely to get reasonable 

results right away.   When you run PHD2 for the first time on your system, this wizard will be 

automatically launched.  Subsequently, you can use the new-profile wizard by clicking on the 'Manage 

Profiles' field in the 'Connect Equipment' dialog, then  choosing 'New using wizard...'.  If you are 

changing cameras and want to keep the dark libraries and bad-pixel maps associated with the old 

camera, you should create a separate profile for the new camera.  When a camera selection is changed in 

an existing profile, the previously built dark library and bad-pixel map data will no longer be usable. 

 

If you already have a suitable default equipment profile and you simply want to connect to the 

equipment "just like before", you can do a <shift>-click on the main screen 'Camera' button and PHD2 

will automatically re-connect to your hardware.  

Exposure Time and Star Selection 

The guide star can be selected (clicked on) while "looping" is active - in fact, this is the recommended 

method.  It can also be selected after looping has been stopped, but this opens the possibility that the star 

might have moved since the last exposure.  No great precision is required in clicking on the star - PHD2 

will find the star nearest to the cursor.  After you do this, a green box will appear to frame the star.  If 

you pick a star that is too bright, a message box will tell you the star is saturated, and you should either 

use a different star or decrease the exposure duration.  The choice of exposure time will depend entirely 

on your equipment, sky conditions, and the available stars.  The exposure time you choose has two 

major implications:  

1. It affects the signal strength (brightness) of the selected star - a brighter star will stand out better 

from the background and will generally produce better guiding results so long as it is not 

saturated. 

2. It also determines the frequency with which guide commands are sent to the mount - guide 

commands cannot be sent any more frequently than once for each exposure cycle.  Some mounts 

benefit from frequent small guiding adjustments while others do not - you may need to 

experiment to understand what works best for your situation.   

As a starting point, try using exposure durations in the range of one to five seconds.  Rather than 

choosing the star yourself with a mouse-click, you can let PHD2 Auto-select the guide star by using the 

Alt-S keyboard shortcut after stars are visible in the main display.   

 

There is also an Auto exposure time selection available. When exposure is set to Auto, PHD2 will 

attempt to adjust the exposure to keep the selected guide star at a constant signal-to-noise ratio (SNR) 

value. The Auto setting can be especially beneficial for AO users who want to minimize exposure time 

http://openphdguiding.org/man-dev/Tools.htm#Auto-Select_Star
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without losing the guide star. The settings to control Auto-exposure are on the Global Tab of the 

Advanced Dialog.  

Automatic Calibration 

Conventional Mounts 

Two things need to be measured by PHD2 as part of guider calibration:  

1. The angle of the camera relative to the telescope axes  

2. The length of the guide pulse needed to move the telescope by a specific amount 

PHD2 handles these measurements automatically by sending guide pulses to the mount and "watching" 

how far and in which direction the star moves between guide camera images.  This process begins after 

you have selected a star and then clicked on the Guide icon button.  Yellow cross-hairs will appear over 

the original location of your guide star and PHD2 will start to move the mount in various directions, 

tracking how the star moves as a function of what move commands were sent to the mount.  The status 

bar will display the commands as they are sent to the mount, along with the incremental movements of 

the guide star relative to its starting position.  PHD2 will do this on both axes, first moving east and 

west, then north and south.  PHD2 wants to move the star up to 25 pixels in each direction in order to 

get an accurate calibration.  Once this is complete, the crosshairs will turn green and guiding will start 

automatically..   

 

In most cases, calibration will complete automatically without any user involvement.  Obviously, this 

assumes that the mount and all the cable connections are working correctly.  If they are not, the 

calibration is likely to fail with a message that the "star did not move enough";  and you'll need to do 

some trouble-shooting.  If the star has basically not moved at all in one or more directions, you should 
look first at the cable connections and mount behavior. The "manual guide" function under the 'Tools' 

menu can help with this as can the trouble-shooting section of this document.   But if the star has moved 

by some amount in each direction, you may need to adjust a calibration setting called the calibration 

step-size.  PHD2 uses this parameter during calibration as a fixed-size duration of movement.  The 

default value has been chosen to cover a wide range of typical guide scope set-ups, but you may need to 

adjust it for your situation.  For example, an off-axis-guider on a long focal length scope will probably 

need a setting that's different from the default value.   To adjust it, go into the "brain dialog" (Advanced 

Settings) and click on the 'Mount' tab.  On that tab, you'll find a setting for 'Calibration step(ms)', and 

that's where you change the value.  There's even a 'Calculate' button that will help you choose an optimal 

value for the parameter.  Once you've set this value, it will be remembered as part of your equipment 

profile and you probably won't have to adjust it again. 

 

You may also see a calibration failure if you're using a star too close to the celestial pole.  In those 

locations, fixed-length movements in right ascension often move the star only a very small distance.  In 

that case, move to a star location closer to the equator, ideally somewhere in the range of -30 to +30 

degrees declination, and re-run the calibration.  But if this is not feasible, you can adjust the calibration 

step-size upward until calibration succeeds.  You can always review the results of your last calibration 

by using the 'Tools' menu and clicking on 'Review Calibration Data'  That will open a dialog that shows 

a graphical representation of the mount's movements along with the values that were computed 

for guiding your mount.  This window is described elsewhere in the "Calibration Details" section of the 

help file.  As a quick quality check, you can open this window and confirm that 1) the RA and Dec lines 

are roughly perpendicular and 2)  the plotted points are roughly linear with no significant curves, bends, 

or reversals in direction.   If you do see these kinds of odd patterns in the graph, you should probably re-

http://openphdguiding.org/man-dev/Advanced_settings.htm#Global_Tab
http://openphdguiding.org/man-dev/Trouble_shooting.htm
http://openphdguiding.org/man-dev/Advanced_settings.htm
http://openphdguiding.org/man-dev/Advanced_settings.htm
http://openphdguiding.org/man-dev/Tools.htm#Calibration_Details
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do the calibration.  Even with high-end mounts, calibrations can occasionally go awry because of 

environmental conditions, especially wind and bad seeing. 

 

Like all other guide settings, the calibration data is automatically saved as part of your current 

equipment profile.  If nothing has changed in your configuration from one session to the next - even 

over an extended time period - you can restore the previous calibration data and start guiding 

immediately.  This function is located under the 'Tools' menu and is labelled 'Restore Calibration 

Data.'  Remember, the data are saved whenever a full calibration is completed or when you use the 'flip 

calibration data' command under the 'Tools' menu (see below).  If you're using a German equatorial 

mount and the ASCOM interface or you have an 'aux' mount connected, the saved calibration data will 

include the side of pier where you were last guiding; so PHD2 will adjust automatically for your current 

pointing position.  But if you are not using mount interfaces that can return pointing information, you'll 

need to remember which side of the pier was being used the last time you were guiding.  Clicking on 

'Restore Calibration Data' will open a window that shows the results from your last calibration, 

essentially identical to what is shown using 'Review Calibration Data.'  You can quickly check the 

information in this window to be sure the calibration you are restoring is sufficiently accurate and 

relevant to your current set-up.  If it looks good, click on 'Restore' to re-use it. 

 

If you're using an ASCOM mount (or 'aux' mount) connection, PHD2 will also include the calibration 

and target declinations as part of its calculations.  In that case,  guiding moves in right ascension will be 

automatically adjusted to account for the declination of the current guide star, as opposed to the star you 

used for calibration.  This is really just a refinement and isn't critical in most situations, so absence of 

pointing information is not a big problem.  However, if you are concerned about it and are imaging near 

the celestial pole, you should consider calibrating using a star that's also at high declination.  Finally, if 

you have a rotator configured as part of your equipment profile, PHD2 will use its angle position 

property to adjust the calibration for changes in camera angle, thus eliminating another need to re-

calibrate. 

 

After a calibration is completed, PHD2 will "sanity check" the results to be sure the calculations at least 

look reasonable.  If they don't, you will see an 'alert' message at the top of the main window that 

describes the calibration result that looks questionable.  You can choose to ignore the alert or click on 

'Details' to get more information.  It is generally advisable to pay attention to these alerts because there 

is no point in trying to proceed using calibration results that are significantly in error. 

Adaptive Optics Devices 

If you are using an adaptive optics device, there are actually two calibration processes that must 

complete.  The first handles calibration of the tip/tilt mirror in the AO and calculates the magnitude and 

direction of the adjustments as they relate to displacements of the guide star.  The second calibration is 

the one described above, dealing with guide commands that need to be sent to the mount.  Known as 

"bump" commands, these will be issued when the guide star has moved beyond the range of corrections 

that can be achieved with the AO alone.  

Guiding 

Once guiding has begun, diagnostic messages will be displayed in the status bar to show what guide 

commanda are being sent to the mount. PHD2 will continue guiding until you click on the 'stop' 

icon.  To resume guiding, simply start looping exposures again, select your star, and click on the 'Guide' 

button.  You will not need to repeat the calibration in order to resume guiding.  In some cases, PHD2 

http://openphdguiding.org/man-dev/Trouble_shooting.htm#Calibration_sanity_check
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may lose the guide star and you'll be alerted by an audible beep and flashing orange crosshairs.  There 

are several reasons this might occur:  

1. Something may be obscuring the star - clouds, the observatory roof, a tree, etc. 

2. The star may have abruptly moved out of the tracking rectangle because something shifted in the 

mount/camera/cabling infrastructure - cable snags can cause this 

3. The star may have "faded" for some other reason, perhaps because it is overly faint 

Obviously, you'll need to identify the source of the problem and fix it.  However, it's important to 

understand that PHD2 will not start moving the telescope around in an attempt to relocate the guide 

star.  It will simply continue to take exposures and look for the guide star to reappear within the bounds 

of the current tracking rectangle.  When you first start guiding, you may see an 'alert' dialog at the top of 

the window if no dark library or bad-pixel map is being used.  You can choose to ignore this warning 

and continue with guiding, but you are likely to get better results if you spend the few minutes needed to 

construct a dark library for future use. 

 

If you are using a German equatorial mount (GEM), you will usually have to do a "meridian flip" around 

the time your image target crosses the meridian.  This means you will move the telescope around to the 

opposite side of the pier and then resume imaging.  Doing this invalidates the original calibration, 

typically because the declination directions are now reversed.  If you are using an ASCOM (or 'aux' ) 

mount interface, your calibration will be adjusted automatically and you can simply resume guiding 

(assuming you haven't also rotated the camera or focuser).  If you aren't using an interface that returns 

pointing position, you will need to take action to adjust the guider calibration.  You can, of course, 

simply do another calibration on the "new" side of the pier, a process that will typically take only a 

couple of minutes.  Or, you can use the pull-down menu item under 'Tools' to "flip calibration data" and 

then resume guiding immediately.   

 

In some cases, you may want to force a re-calibration.  For example, you may have rotated the guide 

camera as part of resolving a cable problem.  You can do this by clicking on the 'Brain button',  moving 

to the 'Mount' tab, and clicking the 'Clear Calibration' checkbox.  Or, you can simply do a <shift>click 

on the  'Guide' button on the main screen and PHD2 will start a calibration run.   

 

Once you have started guiding, you will almost certainly want to know how things are going.  You can 

of course watch the star in the guide camera display but in many cases you won't be able to see all the 

small adjustments that are taking place.  But PHD2 provides many tools for measuring and displaying 

your performance, as described in the Visualization section.  Several of the guiding algorithms have 

limit settings for the maximum guide correction that can be issued with a single command.  If these 

values are smaller than what is needed to correct the mount's position, you will see an alert dialog at the 

top of the main window advising you of the situation.  If this is a recurring problem, you may want to 

increase the values for these settings or otherwise solve the underlying problem. 

 

   

http://openphdguiding.org/man-dev/Visualization.htm
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Dark Frames and Bad-pixel Maps 

Introduction 

Cameras used for guiding are typically not temperature-regulated and may produce images that appear 

quite noisy.  As a result, guide exposures frequently show obvious defects in the form of  "hot" ("stuck") 

pixels or regions with spurious brightness levels.  If there are too many of these defects, you may have 

trouble identifying and selecting a good guide star - trying to calibrate on a hot pixel is a common 

problem for beginners.  Even after guiding has begun, a spurious hot pixel close to the guide star can 

disrupt the calculations needed for smooth guiding and may case the software to "jump" between the 

real star and the hot pixel.  These sorts of problems can be mitigated by using either of two approaches 

in PHD2: dark frames and bad pixel maps.  All functions related to dark frames and bad-pixel maps are 

located under the top-level 'Darks' menu. 

   

Dark Frames 

PHD2 will build and use a library of dark frames that match the range of exposures you use for 

guiding.  Once the library is built, it will be saved automatically and will be available for use across 

multiple PHD2 sessions.  As a result, you can spend a modest amount of time to build a good dark 

library, then use that library for an extended period of time.  Once you have connected to your camera, 

you can build a dark library from the 'Dark Library...' item under the top-level 'Darks' menu.  That will 

start a dialog that looks like this:  

 

 
 

You use the two controls at the top to specify the minimum and maximum exposure times that will be 

used to acquire dark frames.  The starting, ending, and intermediate values match the exposure times 

used in the main PHD2 window, so you can acquire dark frames that will match any exposure time you 

choose for guiding.  The third control specifies the number of dark frames that will be acquired and 

averaged for each exposure time.  The averaged image is referred to as a "master dark 

frame."  Historically, PHD has used 5 dark frames for this purpose, but you may want to increase that 

number to improve the quality of the master dark frame.  You can also add a note or comment if you 
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wish - this will be embedded in the header of the master dark frames for later reference.   

 

One you've set your parameters, click on 'Start' to begin the process.  If your guide camera does not have 

a shutter - most do not - you'll be prompted by PHD2 to cover the guide scope.  To get the best results, 

be sure there is no light leakage into the guide camera - doing this in daylight is not likely to work 

well.  PHD2 will systematically work through the range of exposure times you've chosen, taking the 

specified number of frames for each exposure time.  Progress will be displayed on the status bar at the 

bottom of the window, so you can see where you are in the overall process.  Once you've started the 

process, the 'Cancel' button above will change to a 'Stop' button.  You can click on this if something 

goes wrong or you want to change the parameters before the entire sequence completes.  Stopping in this 

way will discard whatever data has already been collected, so you'll need to make your corrections and 

then restart the process.   Once all the frames have been collected, PHD2 will compute the master dark 

frames, store them in a dark library data file, then show a message box summarizing the results.  If your 

camera has no shutter, you'll also be prompted to uncover the guide scope so you can return to normal 

imaging. 

 

Once your dark library has been built, you control its use by the 'Use Dark Library'  item under the 

'Darks' menu.  The checkbox on the menu item will toggle on or off each time you click on it.  The 

setting of the item is retained across program executions, so if you choose to leave the menu item 

checked, PHD2 will automatically load the dark library and resume its use the next time you run the 

application.  The dark library itself is retained on disk until you build a new library, so you can freely 

change the setting on the 'Use Dark Library' menu item without loss of any data.  If you are using a dark 

library and there is no master dark frame that exactly matches your guide exposure time, PHD2 will use 

the nearest fit.  However, you are encouraged to obtain matching master dark frames for best results.  If 

you have a dark library that has missing exposure times, you can simply acquire the missing data and it 

will be added to the existing dark library - there is no need to start over.  By changing the setting of the 

'Use Dark Library' menu item, you'll be able to see the effect of using the dark library and determine 

whether your guider images are sufficiently improved. 

 

Remember that a dark library is associated with a particular camera.  PHD2 will check to be sure that the 

dark library matches the camera you are currently using.  If it does not, you will see an alert message 

telling you the dark library can't be used and must be rebuilt.  This can happen when you've changed 

cameras inside an existing equipment profile, something you shouldn't do unless you have upgraded 

your guide camera and have no plan to revert to use of the old camera. 

Bad-pixel Maps (Defect Maps) 

For some guide cameras, dark frames don't do an adequate job of removing the defective pixels that are 

visible in the guide frame.  In those situations, you can probably get better results by building and using 

a bad-pixel map.  This approach directly measures and compensates for specific areas of the sensor that 

produce false signal (hot/stuck pixels) or don't respond correctly to incoming light (cold pixels).  Such a 

"map" is created by taking a sequence of comparatively long dark exposures (e.g. 15 seconds), 

averaging them, then statistically analyzing the resultant frame to identify the locations of defective 

pixels.  These pixel locations are saved for future use.  During normal guiding, each of these pixel 

locations on the guide image is replaced by a statistical sample of the surrounding pixels, thus 

eliminating all or most of the effect of the "bad" pixel.  The final result is usually an image with a 

smoother background and fewer obvious defects.  For any defects that remain, PHD2 also provides a 

way for you to manually click on bad pixel locations and add them to the map.  This entire process of 

obtaining and analyzing dark frames is handled for you by PHD2, so it's easy to build a bad-pixel map. 

 



Page 14 of 44 
 

Building a bad-pixel map is done by clicking on the 'Bad Pixel Map...' item under the top-level 'Darks' 

menu.  If you are doing this for the first time, you will be prompted to obtain a sequence of dark frames 

for analyzing your camera sensor and building the map:  

 

 
 

This is a slightly different version of the dialog used for obtaining dark frames, described in the previous 

section.  Because the analysis is based on statistics, you should use relatively long exposure times (> 10 

sec) and at least 10 frames.  Since the bad-pixel map can be re-used for fairly long time periods, you 

won't have to repeat this operation very often, and it's worth spending some time to get higher quality 

data.  

 

Once the dark frames have been captured, PHD2 will compute the statistics and identify an initial set of 

defective or suspect pixel locations.  After a short delay, you'll then see a dialog that looks something 

like this:  
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The 'General Information' section shows a summary of the statistics computed by PHD2 during the 

identification of bad pixel locations.  Normally, you won't need to look at these, and you can hide this 

portion of the display by clearing the 'Show Master Dark Details' checkbox.  The "Results" group shows 

the counts for hot and cold pixels based on the current settings of the two "Aggressivness" sliders below 

them.  If you're doing this for the first time, the aggressiveness sliders will be set at their default values, 

75 within the range of 0 to 100.  You'll need to experiment or make some judgment about whether the 

counts look reasonable based on what you see on your normal guide frames.  If you adjust the 

aggressiveness sliders left and right, you'll see the hot and cold pixel counts change.  The sliders control 

how "aggressive" PHD2 should be in identifying suspect pixels and flagging them as being defective - 

so higher aggressiveness settings will result in higher pixel counts.   Once the settings are where you 

want them, click on the 'Generate' button to compute and load the new defect map.   

 

At this point, you'll probably want to examine the results.  The main window of PHD2 is still active, so 

you can take a normal guide exposure to see how things look.  If you want to quickly see the result of 

using the defect map, just toggle the 'Use Bad-pixel Map' menu item under the 'Darks' menu.   Keep in 

mind that you don't need to achieve a perfectly smooth, black background in the guider image - you just 

need to have a sufficiently small number of remaining hot/cold pixels that neither you nor the PHD2 

guiding algorithms will mistake a bad pixel for a star.  If you over-correct with very aggressive settings, 

you may create so many bad pixel areas that they interfere with detection of usable guide stars.  It's easy 

to make adjustments with the sliders  - just change the slider settings, click on 'Generate' again, and look 

at the results in the main PHD2 window. 

 

You may find that this statistical approach still leaves a few hot pixels that you'd like to eliminate.   You 

can do this quickly and easily by manually adding the bad pixels to the map.  Just use the main PHD2 

window to take a guide exposure, then click on the hot pixel you want to remove.  PHD2 will highlight 

that area with the green tracking box, at which time you can click on the 'Add Bad Pixel' button in the 

dialog box shown above.  This automatically updates the map with the pixel location you just identified 

and immediately reloads the map, so you should see the result in the next guide exposure you take.  You 

can continue with this process until you are satisfied with the results.  Remember, you don't need 

"perfect", just "good enough."   

 

Once your bad-pixel map has been built, you control its use by the 'Use Bad-pixel Map'  item under the 

'Darks' menu.  This setting is retained across program executions, so leaving it checked will tell PHD2 to 

automatically load the defect map and use it for all guide exposures.  The settings for 'Use Dark Library' 

and 'Use Bad-pixel Map' are mutually exclusive - you can use one or neither, but not both at the same 

time.  As with the dark library, the bad-pixel map data file is stored permanently, so you can disable its 

use without losing any data.  Both of these data structures can be used for extended time periods, but it's 

worth remembering that camera sensors do change over time.  As a result, you may want to rebuild the 

dark library or bad-pixel maps at periodic intervals or when you start to see a degradation in the 

appearance of your normal guide images.  In these cases, it is also advisable to click on the checkbox for 

'Rebuild Master Dark Frame', which will tell PHD2 to reacquire the underlying dark frames and 

recompute a baseline bad-pixel map.  You'll then need to refine the map as you did before until you're 

happy with the results.  There is no reason you should need to interact with either the dark libarary or 

bad-pixel map data files, but you can find them located in the 'AppData\Local' logical directory used by 

your operating system. 

 

Like dark libraries, bad-pixel maps are associated with a particular camera.  PHD2 will check to be sure 

that the bad-pixel map matches the camera you are currently using.  If it does not, you will see an alert 

message telling you the bad-pixel map can't be used and must be rebuilt.  This can happen when you've 



Page 16 of 44 
 

changed cameras inside an existing equipment profile, something you shouldn't do unless you have 

upgraded your guide camera and have no plan to revert to use of the old camera. 

Visualization Tools 

PHD2 provides numerous visualization and display tools to help you see how your guider is 

performing.  All of these tools are accessed under the 'View' pull-down menu and are described below. 

 Overlays 

 Graphical Display 

 Stats Display 

 Star Profile and Target Displays 

 AO Graph 

 Dockable Windows 

Overlays 

The simplest display tools are grid overlays superimposed over the main guider display window.  These 

are quite straightforward and include the following choices: 

 Bullseye target 

 Fine grid 

 Coarse grid 

 RA/Dec - this shows how the telescope axes are aligned relative to the axes of the camera sensor 

 None 

You can just click on the various overlay options under the 'View' menu and choose one that suits you.  

Graphical Display 

The graphical display window is one of the more powerful tools for judging guiding performance, and 

you will probably learn to rely on it.  A typical example is shown below:  

 

 

 

The major portion of the window shows the detailed displacements of the guide star for each guide 

exposure, plotted left-to-right.  Normally, one line shows displacements in right ascension while the 

http://openphdguiding.org/man-dev/Visualization.htm#Overlays
http://openphdguiding.org/man-dev/Visualization.htm#Graphical_Display
http://openphdguiding.org/man-dev/Visualization.htm#Stats_Display
http://openphdguiding.org/man-dev/Visualization.htm#Star_Profile_and_Target_Displays
http://openphdguiding.org/man-dev/Visualization.htm#Adaptive_Optics_AO_Graph
http://openphdguiding.org/man-dev/Visualization.htm#DockableMoveable_Graphical_Windows
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second line shows declination displacements.  However, you can use the 'Settings' button to the left of 

the graph to switch to camera (X/Y) axes if you prefer.  You can also use the 'Settings' button to switch 

between display units of arc-seconds vs. camera pixels or to change the colors of the two graph 

lines.  The range of the vertical axis is controlled by the second button from the top, labelled y:+/-4" in 

this example.  The range of the horizontal axis - the number of guide exposures being plotted -  is 

controlled by the topmost button, labelled x:100 in this example.  This scale also controls the sample 

size used for calculating the statistics you see in the lower left part of the graph window.  These values 

show the root-mean-square (RMS or standard deviation) of the motions in each axis along with the total 

for both axes.  These are probably your  best estimators of guiding performance because they can be 

directly compared to star sizes and seeing conditions.  The 'RA Osc'  value shows the odds that the 

current RA move is in the opposite direction as the last RA move.  If you are too aggressive in your 

guiding and over-shooting the mark each time, this number will head toward 1.0.  If you were perfect 

and not over- or under-shooting and your mount had no periodic error, the score would be 0.5  Taking 

periodic error into account, the ideal value would be closer to 0.3.  If this score gets very low (e.g. 0.1), 

you may want to increase the RA aggressivness or decrease the hysteresis.  If it gets quite high (e.g. 0.8), 

you may want adjust aggressivness/hysteresis in the opposite direction. There are two other checkboxes 

to the left that can help you evaluate guider performance.  Clicking on the 'Corrections' box results in an 

overlay showing when guide commands are actually sent to the mount, along with their direction and 

magnitude.  In this example, these are shown as the vertical red and green lines appearing at irregular 

intervals along the horizontal axis.  This shows you how "busy" the guiding is - under optimal 

conditions, you should expect to see extended intervals when no guide commands are sent at all.  The 

other checkbox, labelled 'Trendlines', will superimpose trend lines in both axes to show if there is a 

consistent overall drift in the star position.  This is primarily useful for drift aligning where the 

declination trendline is used extensively.  But the RA trendline can show if your mount is tracking 

systematically slow or fast (or is seeing the effects of flexure) and can help if you are trying to set up 

custom tracking rates.  If dithering commands are issued, usually by an external imaging application, a 

'dithering' label will be superimposed on the graph in the appropriate time interval.  This tells you that 

the star displacements being graphed are being influenced by the dithering operation. 

 

The recommended way to look at guiding performance is to use units of arc-seconds rather than 

pixels.  Doing this allows an equipment-independent way of evaluating performance because it 

transcends questions of focal length and image scale.  To do this, you need to provide PHD2 with 

sufficient information to determine your guider image scale: namely, the focal length of the guide scope 

and the size of the guide camera pixels.  These parameters are set in the 'Brain' dialog, on the 'Global' 

and 'Camera' tabs, respectively.  If they are not specified, PHD2 will use default values of 1.0, and the 

guiding performance numbers will effectively be reported in units of pixels. 

 

At the bottom of the graph window are active controls for adjusting guiding parameters "on the 

fly".  The guiding algorithm selections you've made will control which controls are shown.  These 

controls have the same effect as those in the 'Brain' dialog, and they eliminate the need to stop guiding 

and navigate to another window to adjust guiding parameters. 

 

 

 

 



Page 18 of 44 
 

Stats 

 
 

If you want to monitor guiding performance without necessarily having the graph window open, you can 

click on  the "Stats" menu item.  That will display the salient statistics with controls for clearing the data 

or changing the number of guide exposures used to compute the statistics.  

Star Profile and Target Displays 

 
 

The star profile display shows the cross-section of the guide star along with a measurement of its full-

width-half-maximum (FWHM).  If you see substantial fluctuations in this parameter, it may be an 

indication that the star is too faint or the exposure time is too short.   
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The target display is another useful way to visualize overall guider performance.  The red 'X' shows the 

star displacement for the most recent guide exposure, while the blue dots show the recent history.  You 

can zoom in or out with the controls at the upper left of the window, as well as change the number of 

points shown in the history.    

Adaptive Optics (AO) Graph 
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The AO graph is equivalent to the 'target' display, but shows the history of corrections relative to the 

axes of the adaptive optics device.  The red rectangle indicates the outer edges of the AO device, while 

the interior yellow rectangle shows the "bump" region.  If the star moves outside the yellow rectangle, 

PHD2 will send a sequence of move commands to the mount - the "bump" - to smoothly place the guide 

star back near the center position.  When this occurs, green and blue lines will show the incremental 

bump and the remaining bump respectively.  The white dot on the display shows the current AO 

position, and the green circle (red when a bump is in progress) shows the averaged AO position.  The 

button in the upper left controls how many points will be plotted in the history.  

Dockable/Moveable Graphical Windows 

When the various performance windows are initially displayed, they are "docked" in the main 

window.  This means they are sized in a particular way and are aligned with two edges of the window - 

they are entirely contained within the bounds of the main PHD2 window.  However, you can move them 

around and resize them by clicking and dragging on the title bar of the window you want to 

examine.  This will often let you get a better view of the details being shown in the graphs.  They can 

be re-docked by dragging the title bar to the general region in which you want them docked - bottom, 

right, etc.  With just a bit of practice, it's easy to place them where they are most convenient. 

 

There is also a menu item under the 'View" pulldown menu labeled 'Restore window 

positions.'  Clicking on this menu item will automatically restore all of the dockable/moveable windows 

to their default, docked positions.  This can be useful , for example, if you are switching between screens 

with different resolutions and one or more of the dockable windows has been "lost."  This function also 

restores the main PHD2 window to its default size, with a position near the upper lefthand corner of the 
screen.  

Advanced Settings 

Advanced settings are accessed by clicking on the 'Brain button', a feature well-known to users of the 

original PHD.  PHD2 has a considerably larger set of parameters that can be adjusted to optimize your 

guiding performance.  Although these are called "advanced" settings, they are not particularly difficult 

to understand, and you shouldn't hesitate to explore them.  All of the fields on these forms include "tool 

tips", small message windows that describe each field in some detail.  Simply "hover" the cursor over 

the field to see the tool-tip.  In many cases, this will provide all the information you need.   Because 

there are many more settings available, the Advanced Dialog in PHD2 is organized into tabs, and the 

documentation will follow that model as well.  

 

Global Tab 

Guiding Tab 

Camera Tab 

Mount Tab 

AO Tab 

 

 

 

http://openphdguiding.org/man-dev/Advanced_settings.htm#Global_Tab
http://openphdguiding.org/man-dev/Advanced_settings.htm#Guiding_Tab
http://openphdguiding.org/man-dev/Advanced_settings.htm#Camera_Tab
http://openphdguiding.org/man-dev/Advanced_settings.htm#Mount_Tab
http://openphdguiding.org/man-dev/Advanced_settings.htm#AO_Tab
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Global Tab 

 
 

Most of the fields on the global tab deal with overall program functions and behavior.  Several of them 

deal with  logging and debugging functions, which will be discussed first.  

Logging and Debug Output 

PHD2 can optionally produce two types of log files: a debug log and a guiding log.  Both are highly 

useful for different reasons.  The guiding log is similar to the one produced by PHD, but with extended 

information. The guide log is intentionally formatted to allow easy interpretation by either a human 

reader or an external application.  For example, the PHDLab application (not part of the PHD2 project) 

can produce a variety of graphs and summary statistics based on data in the PHD2 guide log.   But the 

log can also be easily imported into Excel or other applications for analysis and graphing.  When 

importing into Excel, just specify that a comma should be used as a column separator.  The debug log 

has a  complete record of everything that was done in the PHD2 session,  so it is very helpful in isolating 

any problems you  have.  It also employs a human-friendly (albeit verbose) text format, so it's not 

difficult to examine the debug log to see what happened.  If you need to report a problem with the 

software, you will almost certainly be asked to provide the debug log file.  If you have neither log file 
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available, you are unlikely to get any help. 

 

The location for the files is controlled by the 'Log File Location' field further down in the dialog.  By 

default, log files are stored in the OS-specific default directory for application data files.  In Windows7, 

for example, the files will be stored in a 'PHD2' sub-folder in the "AppData\Local" location.  This may 

not be a convenient location, so you can specify a different folder using this edit field. 

 

In some unusual cases, you may need to capture guide camera images, usually to support debugging and 

problem resolution.  

 

General Parameters 

The remaining controls on the 'Global' tab are well-described by their respective tool-tips, but they are 

summarized here for completeness: 

 'Reset Configuration' - restores all settings to their initial values as if PHD2 had been freshly 

installed 

 'Image format' - specifies the file format if star-image logging is enabled 

 'Dither RA only' - for companion apps that use the PHD2 server interface, specifies that 

dithering should be done only on the RA axis 

 'Dither scale' - controls the magnitude of the dithering operation  

 'Noise reduction' - specifies the algorithm to use for handling noisy guide camera images - those 

for which dark frames are not sufficient.  Choices include None, 2x2 mean, and 3x3 median. 

Both 2x2 mean and 3x3 median will reduce the noise considerably. 3x3 median is especially 

effective at removing hot pixels and neither will significantly affect guiding 

accuracy.  However,  creating a bad-pixel map is likely to be a better solution with less impact on 

your ability to detect faint stars. 

 'Time lapse' - imposes a fixed delay between guide exposures.  This can be useful if the guide 

exposures are very short and you don't want to overload either the mount or the camera link with 

very high traffic rates. 

 'Focal length' - the focal length of the guide scope (millimeters). This provides one of two 

parameters needed by PHD2 to compute the image scale and thus report guiding performance in 

units of arc-seconds.  The other parameter required for this is the guide camera pixel size, located 

on the 'Camera' tab. 

 'Language' - determines the language used in the PHD2 user interface, subject to available 

localization.  Changing this will usually require a program restart 

 'Auto restore calibration' - tells PHD2 to automatically reload the most recent calibration data as 

soon as the equipment is connected.  Be sure to read the Auto calibration section to understand 

the implications and potential risks of doing this. 

 'Auto Exposure' - these are the settings that control Auto exposure time. 

o Min Exposure - the minimum exposure time. PHD2 will not set the exposure time less 

than this value, even if the guide star SNR is higher than the target SNR value. If the min 

exposure time is set too low, you could end up sending excessive small corrections to the 

mount which may not give the best guiding results. Users with AO units would want to 

set this to a lower value, since rapid small corrections are often desirable with an AO. 

o Max Exposure - the maximum exposure time. Before a guide star is selected, PHD2 will 

set the exposure time to the maximum value. Once a guide star is selected, PHD2 will 

then incrementally decrease the exposure time until the desired SNR is reached. 

http://openphdguiding.org/man-dev/Basic_use.htm#Automatic_Calibration
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o Target SNR - this is the average SNR value that PHD2 will attempt to achieve by 

adjusting the exposure time. SNR can fluctuate from frame to frame even with a fixed 

exposure duration, so be sure to account for that when choosing a target SNR value. 

PHD2 will reject frames when SNR drops below 3.0. The default value of 6.0 should 

provide enough of a cushion to prevent fluctuations from causing the SNR to go below 

3.0. 

Guiding Tab 

 
 

There are relatively few parameters found on the 'Guiding' tab.  Their use is as follows:  

 'Always Scale Images' - tells PHD2 to always rescale the guider image to fit the display 

window.  PHD2 does this automatically in almost all cases, so you'll rarely need to do this. 

 'Fast re-center after calibration or dither' - during calibration or dithering, the mount may be 

moved a significant distance from the initial "lock" position.  If you click this checkbox, PHD2 

will move the mount back to the lock position as quickly as possible, using the largest guide 
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commands permitted by the 'Max Duration' settings of your guide algorithms.  This is only an 

optimization, so the use of this checkbox is completely optional. 

 'Search region' - specifies the size of the "tracking rectangle", in units of pixels.  You may need 

to increase this value if your mount does not perform well or, more commonly, if it's not well-

aligned on the celestial pole. 

 'Star mass change detection' - tells PHD2 to monitor the brightness and size of the guide star 

compared to the sky background.   

 'Star mass tolerance' - if 'star mass change detection' is checked, PHD2 will trigger a 'lost star' 

error if the measured brightness and size vary by more than this percentage.  This might be 

useful if you have two stars inside the tracking rectangle and you want to be sure that PHD2 

doesn't mistakenly switch stars.  It can also prevent errors caused by thin clouds, high camera 

noise, or alpha particle "hits"; but it may be unreliable if you are guiding on a faint star.  If you 

are getting too many 'lost star' errors when the star is plainly visible on the display, try increasing 

the value of this setting.  Setting the value to 100 effectively disables the warnings entirely. 

Camera Tab 

 
 

The controls on the 'Camera' tab are used as follows:  
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 'Use subframes' - For cameras that support this feature, PHD2 will download only a subframe of 

each guide exposure. This is very useful for cameras with slow download times and can mean 

the difference between the camera being too slow to effectively guide and being quite 

responsive. When this feature is enabled, only a small subframe (100x100 pixels) will be 

downloaded once a star is selected. This feature applies to both calibration and guiding.  During 

initial looping without a selected star, the full frame is downloaded, but once a star is selected, 

only this small subframe is downloaded.   If you are using subframes but want to see the full 

frame to select a different star, just click anywhere outside the subframe. 

 'Pixel size' - The guide camera pixel size in microns. This is the second of two parameters 

needed by PHD2 to compute the guider image scale and thus report guider statistics in units of 

arc-seconds.  Refer to your camera documentation to determine the correct value. 

 'Camera gain' - Sets the gain level for the many cameras that support this feature. If you really 

want to use a bright star and a longer exposure duration or if your camera makes a very noisy 

image, try reducing this parameter. 

 'Disconnect nonresponsive camera after (seconds) - Camera malfunctions will sometimes occur, 

often because of faulty USB connections.  In many cases, the camera will not return the 

requested image data, and PHD2 will appear to "hang."  This parameter determines how long 

PHD2 should wait for a response after the expected exposure time has expired.  For example, a 

timeout value of 5 seconds in conjunction with an exposure time of 2 seconds will tell PHD2 to 

wait up to 7 seconds for a response.  If the data are not received within that period, PHD2 will 

attempt to halt the operation, disconnect the camera, and display an alert message in the main 

window.  Since a hardware problem is likely the underlying issue, this recovery attempt won't 

always succeed.  It is advisable to be  generous with these timeout values to avoid spurious 

recovery actions.  Also, if you are using a guide camera that shares electronics with the main 

imaging camera, you should set this timeout to a large value, well above the maximum expected 

time for a full-frame download from the main imager.  At this time, this affects users of 

the SBIG driver that is packaged with Sequence Generator Pro.  Regardless of whether PHD2 is 

able to handle the situation gracefully, the underlying problem is almost certainly in the 

hardware or the camera driver and will need to be resolved before guiding is continued. 
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Mount Tab 

 
 

The mount tab is the most complex area of Advanced Settings largely because it has so many parameters 

and UI controls.  Most of these settings are closely tied to the various guiding algorithms, and the 

contents of the dialog will change significantly if you change the algorithm selections.  For that reason, 

all the parameters related to guide algorithms will be treated together, in a separate section. 

 

The remaining controls, the ones that are independent of the guiding algorithm selections, are described 

below.  

 'Clear calibration' - tells PHD2  you want to clear the calibration data currently being used and 

re-calibrate before guiding is restarted.  You might do this for a variety of reasons - you might 

have moved the guide camera, you might have done a meridian flip and want to recalibrate on 

the "new" side of the pier, etc.  You can also accomplish the same result by doing a Shift-Click 

on the guiding icon on the main page, which will force a re-calibration. 

 'Enable guide output' - this is normally checked because it tells PHD2 to send guide 

commands to the mount.  But there are some circumstances where you might want to disable 

http://openphdguiding.org/man-dev/Guide_algorithms.htm
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this, usually because you want to observe the uncorrected behavior of the mount.  For example, 

you can disable guider output in order to see the general shape and amplitude of your mount's 

periodic error or to check the amount of drift from polar mis-alignment.   

 'Calibration step-size' - specifes the duration of the guide pulse that PHD2 will use during 

calibration.  Its use is described in the 'Auto Calibration' section of the 'Basic Use' help 

page.  You can adjust the value depending on whether the guide star is moving too quickly or too 

slowly during calibration.  As a general guideline, it is good to calibrate within about 30 degrees 

of the celestial equator (declination = 0), and to use a calibration step size that will result in 8-

14 steps in each direction.   The 'calculate...' button to the right of this control will launch a 

dialog that can help you compute an appropriate value:  

 

 
 

To use the calculator, be sure the topmost three edit controls are correctly filled in.  If you have already 

specified the focal length and the camera pixel size in the 'Global' and 'Camera' tabs respectively, those 

fields will already be populated in this form.  If you are using an ASCOM connection to your mount, the 

fields for "Guide speed" and "Calibration declination" will also have the correct values.  Otherwise, 

you'll need to supply them yourself.  The guide speed is specified as a multiple of sidereal speed - most 

mounts will use something like 1X or 0.5X sidereal, but you can choose something else.  You can leave 

the 'calibration steps' field at the default value of 12, which is likely to result in a good calibration.  Use 

of a significantly smaller value raises the likelihood that seeing errors or small mount errors will cause 
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calibration errors .  As you change the values in these fields,  PHD2 will recalculate your current image 

scale and a recommended value for the calibration step-size.  If you then click on 'Ok', that value will be 

inserted into the calibration step-size field of the 'Mount' dialog.  Clicking 'Ok' will also populate the 

focal length and camera pixel size fields in the 'Global' and 'Camera' tabs, so any changes you made in 

the calculator will be reflected there as well.  However, this will not be done if you click on 'Cancel' in 

the calculator dialog.  

 'Max Duration RA' - specifies the maximum allowed guide pulse duration for right 

ascension.  You might reduce this below the default value if you want to avoid "chasing" a large 

deflection that could be caused by a spurious event (e.g. a sudden 'hot pixel') .' 

 'Max Duration Declination' - specifies the maximum allowed guide pulse duration for declination 

(same as above but for declination).  This can be useful to avoid over-correction and subsequent 

direction reversal in declination guiding. 

 'Reverse Dec output after meridian flip' - tells PHD2 how to adjust the calibration data when you 

use the function to "flip" it.  Some mounts track their 'side of pier' state and automatically reverse 

the direction of guide commands in declination.  Others, perhaps most mounts, do not do this.  In 

either case, PHD2 needs to know if the mount will automatically change its behavior based on 

side-of-pier.  You may have difficulty finding information about how your mount behaves in this 

respect, so it's probably easiest to just run a quick experiment.  With the checkbox disabled, 

calibrate on one side of the pier, then move the mount to the other side.  Select  'Flip Calibration' 

under the 'Tools' menu, and start guiding.  If the guiding works normally, leave the box un-

checked; but if you see run-away in declination, check the box and repeat the experiment. 

 'Assume Dec orthogonal to RA' - Normally, the calibration process independently computes the 

camera angles for both right ascension and declination.  There is no need for great precision on 

these values, and the default behavior normally works well.  However, if your mount has very 

high periodic error or you are dealing with very bad seeing conditions, you may want to force the 

RA and Declination angles to be perpendicular.  If you choose that option, PHD2 will compute 

the camera angle for RA, then assert a declination angle that is orthogonal to it. 

All of the other controls in this dialog are related to the guiding algorithms you have chosen and are 

described here: Guiding Algorithms and Settings 

  

http://openphdguiding.org/man-dev/Guide_algorithms.htm
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AO Tab 

 
 

Most of the edit controls at the top of the AO tab have the same meaning as their counterparts on the 

'Mount' tab.  The guiding algorithms apply to the control of the tip/tilt optical element in the AO device 

itself, not to the "bump" commands sent to the mount.  Since the AO device is not trying to move a 

heavy piece of equipment, you can afford to be more aggressive in your guide algorithm parameters.  If 

you use a hysteresis-based algorithm, for example, you should probably start with a high level of 

aggressiveness, perhaps 100%.  Or you can choose the 'None' algorithm, which means there will be no 

damping or history-based algorithm applied at all.  In that case, each correction will be based only on the 

most recent guide frame and will make a 100% correction of the most recent deflection.   

 

You can use the four parameters at the bottom of the AO tab to control the calibration process and the 

manner in which 'bump' operations are done.  The 'calibration step' field tells PHD2 the amount to move 

the tip/tilt element in each of the up/down/left/right directions, in units of AO steps, during 

calibration.  The guide star position is measured at the beginning and end of each leg of the calibration, 

and the 'samples to average' parameter tells PHD2 how many samples to take at each of these 

points.  Averaging images is important because the seeing will always cause the guide star to "bounce 

around" a bit.  As discussed earlier, the AO unit can make corrections only within a limited range of 
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guide star movement.  You will want to initiate mount 'bump' corrections before these limits are actually 

reached, and the 'bump percentage' field is used for that purpose.  To move the mount, the full bump 

correction is accomplished in steps - the 'bump step' field controls the size of these increments.  If the 

bump operation has begun and the guide star remains outside the "bump percentage" area, PHD2 will 

increase the bump size until the guide star is back within that range.  Additional movement from that 

point to the center position will continue at the specified "bump step size".  This complexity is required 

in order to maintain good guiding, with no elongated stars, even as the mount is being bumped.  During 

the bump operation, the AO is continuing to make corrections, so the long "mount bump" is 

continuously offset by adjustments in the AO. 

Rotator Tab 

Currently, the rotator tab has only one control, and this window is likely to change in the future.  The 

"Reversed" checkbox can be used for optical systems that reverse the image because they have an odd 

number of mirrors.  The direction and amount of rotation is used to adjust the calibration data, so PHD2 

follows the ASCOM standard:  "the rotator position is expressed as an angle from 0 up to but not 

including 360 degrees, counter-clockwise against the sky."  

Guide Algorithms 

Guiding Theory 

Guide Algorithm Parameters 

Guiding Theory 

The default guiding algorithms in PHD2 are well-established and should work well for most 

users.  Unless you already have some experience with guiding and understand the basics, you should 

probably be cautious about changing algorithms.  However, you may have some special circumstances 

that require changes or you may simply want to experiment with the different algorithm choices.  The 

Advanced Dialog settings in PHD2 make it easy to do that.  Each algorithm has a set of parameters that 

controls how observed changes in guide star position (star deflections) are translated into guiding 

commands that are most likely to restore the star to its initial position.  

 

Before discussing the details of these parameters, it is worth reviewing a little guiding theory and 

looking at what these algorithms are trying to accomplish.  Setting aside adaptive optics devices, which 

are entirely different, conventional guiding faces enormous challenges.  The problem at hand is how to 

move machinery that weighs tens or even hundreds of pounds with a level of precision that will not 

cause streaked or oblong stars.  This type of guiding can only hope to deal with tracking errors that are 

"slow and steady", not "fast and random."  Sources of slow and steady (correctable) errors include the 

following:  

 Certain kinds of mechanical imperfections in right ascension gears, including those that 

cause periodic error. 

 Smalll errors in the sidereal tracking rate of the mount 

 Atmospheric refraction - stars appear to move more slowly as they near the horizon 

 Limited kinds of mechanical deflection and flexure - but not differential flexure 

 Mis-alignment of the right ascension axis on the celestial pole 

http://openphdguiding.org/man-dev/Guide_algorithms.htm#Guiding_Theory
http://openphdguiding.org/man-dev/Guide_algorithms.htm#Guide_Algorithm_Parameters
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So what isn't included in the above and isn't correctable by conventional guiding?  Unfortunately, it's a 

very long list, of which a few are:  

 Atmospheric seeing ("turbulence") 

 Gear "noise", roughness, and vibration 

 Differential flexure - relative movement between the imaging scope and the guide scope 

 Wind gusts, cable snags, grit in the drive gears 

 And lots more... 

The common denominator shared by the guide algorithms is the need to somehow react to the slow and 

steady deflections while ignoring the rest.  This is a difficult problem at best because any given guide 

star deflection is likely to have contributions from many of these sources.  And if that isn't hard enough, 

remember that real-world  mounts are never perfect - so the move you ask for will not be exactly the 

move you get.  Usually, the most important requirement for any algorithm is to avoid over-correcting, 

wherein the mount is being pushed back and forth and the guiding never stabilizes.  A typical approach 

in these algorithms is to apply "inertia" or "impedance" to the guiding corrections.  That means making 

corrections that follow a pattern and are generally consistent with corrections that have been made 

before, while being reluctant to make corrections that require a big change in direction or 

amplitude.  Resistance to changes in direction is particularly important in declination, where gear 

backlash is a common problem.  Hopefully, this background will give you enough insight into the basics 

of guiding so that the various guiding parameters used in PHD2 will make sense. 

Guide Algorithm Parameters 

In PHD2, the various guide algorithms can be applied to either the right ascension or declination 

axes.  Most of these algorithms include a minimum move parameter.  This is used to avoid making 
guide corrections that are overly small, are unlikely to have any effect on star shape, and are mostly due 

to transient seeing effects.  These values are entered in units of pixels, so you need to think about them 

in the context of how large your star images are.  The default values work well for short-to-medium 

focal length systems, but you may need to increase them if you are working at long focal lengths and 

expect stars to have larger diameters. 

 

The hysteresis algorithms keep a "memory" of the guiding corrections that have been made in the recent 

past, and these are used to help compute the next guide correction.  The hysteresis parameter, expressed 

as a percentage, specifies the "weight" that should be given to this history as opposed to  looking only at 

the star deflection in the current guide frame.  Consider an example where the hysteresis parameter is 

10%.  In that case, the next guiding correction will be 90% influenced by the star movement seen in the 

current guide frame and 10% by the corrections that have been made in the recent past.  Increasing the 

hysteresis value will smooth out the corrections at the risk of being too slow to react to a legitimate 

change in direction.  The hysteresis algorithms also include an aggressiveness parameter, again 

expressed as a percentage,  that is used to reduce over-correcting.   On each frame, PHD2 computes how 

far it thinks the mount should move and in what direction(s) it should move. The aggressivness 

parameter scales this. For example, take a case where the star deflection has been evaluated and a 

corrective move of 0.5 pixels is warranted.  If the aggressiveness is set to 100%, a guider command will 

be issued to move the mount the full 0.5 pixels.  But if the aggressiveness is set to 60%, the mount will 

be asked to move only 60% of that amount, or 0.3 pixels. If you find your mount is always overshooting 

the star, decrease this value slightly (say, by 10% steps). If you find PHD2 always seems to be lagging 

behind the star's motion, increase this by a little bit. A little can go a long way here.   

 

The ResistSwitch algorithm behaves much as its name implies.  Like the hysteresis algorithms, it also 
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maintains a history of past guide corrections, and any change of direction must be "compelling" in order 

to issue a reversing guide command.  This is appropriate for declination guiding, where reversals in 

direction are both suspect and likely to trigger backlash in the gears.  For that reason, ResistSwitch is the 

default algorithm for declination but not for right ascension, where valid direction reversals are 

expected.  Starting with Release 2.4.1, two additional parameters are available for fine-tuning the 

ResistSwitch algorithm.  The first is "aggression", a percentage amount that controls how much of the 

computed guide correction will be issued.  Reducing this parameter can help to avoid over-shooting with 

mounts that have little or no backlash. The second parameter is a checkbox labeled "Fast switch for 

large deflections."  If this is checked, PHD2 will react immediately to a large change of direction rather 

than waiting for three consecutive deflections in the new direction, which is the normal behavior.  This 

can help to more quickly recover from large excursions in Dec, perhaps caused by wind, cable snags, or 

other mechanical shifts  The definition of a "large deflection" is 3x the minimum-move value.  So if 

PHD2 is over-reacting to direction changes, you can tune the behavior with the min-move parameter or 

disable the "fast switch" option altogether.  It is worth remembering that "less is usually better" when it 

comes to Dec guiding, so don't try to over-tune these parameters. 

 

The LowPass algorithms also employ a history of recent guiding corrections in order to compute 

the next correction.  The starting point for the computed move is the median value of the guide star 

deflections that have occurred in recent history.  This means that the star deflection seen in the current 

guide frame has relatively little impact on calculating the next move and the algorithm is very resistant 

to quick changes.  But the history accumulation also includes a calculation to determine if deflections 

are moving in a consistent direction or "getting worse."  The slope weight parameter, expressed as a 

percentage, determines how much influence this should have in calculating the actual guider movement 

- it is there to keep the algorithm from being overly sluggish.  Because the low-pass algorithm is so 

resistant to quick changes, it is probably most applicable to declination guiding. 

 

The declination guide mode gives you additional control for declination guiding.  Declination guiding is 

not like RA guiding because the errors are not caused by imperfections in your mount's gears.  Instead, 

deflections in declination are primarily the result of imperfect polar alignment.  The result is an error 

that should be smooth and should be in only one direction, assuming there is no over-shoot from an 

earlier correction.  The default value of 'auto' tells PHD2 that some reversals in direction are acceptable, 

subject to the behavior of the various guiding algorithms.  However, if your mount has severe 

declination backlash, you may want to prevent direction reversal altogether.  If so, you can select either 

'north' or 'south' to restrict corrections to one direction only.  Keep in mind, however, that an over-shoot 

in correction with one of these modes will leave the star positoned off-target for an extended period of 

time. So you'll probably want to use conservative parameters for aggressiveness if you are disallowing 

direction reversals.  Finally, a choice of 'none' here disables declination guiding altogether. 
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Tools and Utilities 

Manual Guide 

Auto-Select Star 

Calibration Data 

PHD2 Server 

Drift Alignment 

Lock Positions 

Comet Tracking 

Equipment Profiles 

Simulator Parameters 

Manual Guide 

 

 
 

If you are connecting to a new mount and are encountering calibration problems, you will probably want 

to be sure that PHD2's commands are actually getting to the mount. Or you may want to nudge the 

mount or experiment with manual dithering.  In the 'Tools' menu, click on 'Manual Guide' and a dialog 

will appear to let you move the mount at guide speed in any direction. Each time you press the button, a 

pulse of the duration specified in the 'Guide Pulse Duration' field will be sent.  The default value is the 

'calibration step-sze' set in the Advanced Options dialog.  If you are debugging calibration problems, 

listen to (rather than watch) your mount to determine if the mount is getting the commands from PHD2. 

The idea here is just to figure out if the mount is responding to PHD2's signals. You won't be able to see 

the mount move (it's moving at guide speed) but you may be able to hear it. Other options include 

watching the motors themselves or attaching a laser pointer to your scope and aiming it at something 

fairly far away (to amplify your motions).  If you have an adaptive optics device attached, you'll see 

separate move buttons for both the AO and the secondary mount.   

 

Dithering is used primarily with image capture or automation applications, usually through the PHD2 

server interface.  However, you can do manual dithering or experiment with dither settings using the 

controls at the bottom of the dialog.  The 'dither' amount field at the left controls the amount the mount 

will be moved , in units of pixels.  You can scale this amount - i.e. multiply it by a constant - by using 

the 'scale' spin control to the right.  These two controls establish a maximum amount of movement that 

will be used for dithering - the product of 'scale' X 'dither'.  When you click on the 'Dither' button, PHD2 

will move the mount by a random amount that is less than or equal to the limit you have set, in one of 

http://openphdguiding.org/man-dev/Tools.htm#Manual_Guide
http://openphdguiding.org/man-dev/Tools.htm#Auto-Select_Star
http://openphdguiding.org/man-dev/Tools.htm#Manual_Control_of_Calibration_Data
http://openphdguiding.org/man-dev/Tools.htm#PHD2_Server
http://openphdguiding.org/man-dev/Tools.htm#Drift_Align
http://openphdguiding.org/man-dev/Tools.htm#Lock_Positions
http://openphdguiding.org/man-dev/Tools.htm#Comet_Tracking
http://openphdguiding.org/man-dev/Tools.htm#Managing_Equipment_Profiles
http://openphdguiding.org/man-dev/Tools.htm#Advanced_Settings_for_the_Simulators
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the north/south/east/west directions.  The 'RA Only' checkbox will constrain the dither adjustments to 

only east or west.  Obviously, if you are doing a manual dither in this way, you'll want to be sure your 

imaging camera is not in the middle of an exposure. 

Auto-Select Star 

Clicking on 'Auto-select Star' under the 'Tools' menu, or using the keyboard shortcut of <Alt>S, tells 

PHD2 to scan the current guide image and identify a star suitable for guiding.  PHD2 will try to select a 

star of sufficient brightness that is not near another star and not too close to the edge of the frame.  The 

selected star may appear overly dim on the screen, but this is usually not a problem.  You can use 

the Star Profile tool to examine the properties of the selected star - it should be non-saturated with a 

sharp profile, the same properties you should look for when choosing a guide star manually.  The auto-

select process is not infallible, so you may need to select a star yourself if you don't like the automated 

result.  If you want to use Auto-Select, you should definitely use either a bad-pixel map or dark library 

to reduce the likelihood of PHD2 mistakenly choosing a hot pixel.  

Calibration Data Details 

Calibration data is saved automatically each time a calibration sequence completes successfully.  The 

use of the calibration data has been described elsewhere (Using PHD Guiding), including  options for 

restoring calibration data from an earlier time or "flipping" it after a meridian flip.  You access these 

functions using the 'Calibration' sub-menu under the 'Tools' menu.  Two other calibration-related items 

are  shown there, namely the options to clear the current data or to enter calibration data manually.  The 

"clear" option accomplishes the same thing as the 'Clear calibration' checkbox in the Advanced Dialog - 

it will force a recalibration whenever guiding is resumed.  The 'Enter calibration data' option should be 

used only under very unusual circumstances and only if you're sure you know what you're doing; but it 

is available as a matter of completeness.  If you click on the 'Enter calibration data' item, you'll see a 

dialog box that allows input of relatively low-level calibration data.  This data might come from a much 

earlier session, perhaps extracted from the PHD2 guiding log file. 

 

Most of the calibration-related windows, including calibration sanity-checks, will open a window that 

looks something like this: 

 

 

http://openphdguiding.org/man-dev/Visualization.htm#Star_Profile_and_Target_Displays
http://openphdguiding.org/man-dev/Basic_use.htm
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The first thing to look at is the graph to the left, which shows what star movements resulted from the 

guide pulses that PHD2 sent during calibration.  The lines represent the RA and Dec guide rates that 

were computed as a result of the calibration, and these lines should be roughly perpendicular.  The data 

points will never be perfectly aligned, but they should not have major curves, sharp inflections, or 

reversals in direction.  The tabular information to the right shows what was known about the pointing 

position of the scope and the various ASCOM settings that relate to guiding.  If you are not using an 

ASCOM mount and don't have an "Aux mount" specified, some of this information will be 

missing.  The table will also show the expected guiding rates for a "perfect" calibration using the same 

sky position and guide speed settings you used.  You will almost never achieve these ideal values, and 

you shouldn't worry about them unless your values are very different.  If you didn't see an alert message 

when the calibration completed, your results are probably good enough.   If you want to re-use a 

calibration for an extended time,  it is probably worth a few extra minutes to check this information and 

confirm that the calibration went reasonably well and produced sensible results.  Bad calibrations can 

occur even for very experienced imagers using high-end mounts, so it is good to check. 

PHD2 Server 

PHD2 supports third-party imaging and automation applications that need to control the guiding 

process.  Stark Labs' Nebulosity program was the first to do this, but other applications have 

subsequently been produced.  By using the PHD2 server process, image capture programs can control 

dithering between exposures or suspend guide exposures while the primary imaging camera is 

downloading data.  To use these capabilities with a compatible application, you should click on  the 

'Enable Server' option under the 'Tools' menu.  The server interface has been reworked substantially in 
PHD2, and it's now possible for an application to control most aspects of PHD2's guiding 

operations.  Documentation for the server API is available on the PHD2 Wiki. 

Drift Align 

Drift alignment is a well-known technique for achieving polar alignment and is considered by many to 

be the "gold standard".  The Drift Alignment tool is a wizard-like sequence of dialogs that can help you 

work through the drift alignment process and get quantifiable results.  Once you've calibrated your 

guider, click on 'Drift Align' under the 'Tools' menu.  The first Drift Align dialog will appear to help you 

adjust the azimuth on your mount.  If you are using an ASCOM mount, you'll have the option of slewing 

to an area near the celestial equator and the celestial meridian.  If you're not using an ASCOM mount, 

you'll need to slew to that location manually.  Once the scope is positioned and you have a suitable star 

in the field of view, click on the 'Drift' button to begin collecting data.  You'll see the graph window with 

a display of star deflections and corrections and, more importantly, two trendlines. When the mount is 

precisely polar aligned in azimuth, the Declination trend line will be perfectly horizontal.  Let the 

exposures continue until the declination trendline has stabilized and is no longer jumping around with 

each new exposure.  At the bottom of the graph window, you'll see a measurement for the polar 

alignment error in azimuth. And, in the image window, you will see a magenta circle around the guide 

star. The circle indicates an upper limit on how far the guide star needs to move when azimuth is 

adjusted. (Initially, the circle may be too large to be visible on the screen, so you may not see it until 

your alignment gets closer.) 

 

Now click on the 'Adjust' button to halt guiding, then make a  mechanical adjustment in azimuth. Watch 

the guide star as you make the adjustment, moving the guide star towards the magenta circle, but not 

beyond it. Once done, click on the 'drift' button again to repeat the measurement. If your adjustment was 

in the right direction and did not over-shoot, the Declination trendline will be closer to 

https://code.google.com/p/open-phd-guiding/w/list
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horizontal.  Continue iterating in this way until you are satisfied with your azimuth accuracy.  You can 

use the 'notes' field to record which way the drift line moves depending on how you make the 

adjustment.  For example, you might note that a counter-clockwise turn of the mount azimuth knob 

moves the drift line "up."  Since these notes are retained across PHD2 sessions, subsequent drift 

alignments will probably proceed more quickly. 

 

Until you are experienced with drift aligning your particular mount, the 'adjustment' part of the process 

can be a bit tedious.  At first, you'll have to determine how to adjust a knob on the mount to achieve the 

desired effect: "how much" and "what direction."  To help with this, the PHD2 drift align tool supports 

"bookmarks".  These are a handy way to record the positions of the guide star before and after you've 

made an adjustment.  Bookmarks are accessed using the Bookmarks menu, or keyboard shortcuts, as 

follows:  

 b : toggle/show bookmarks  

 Shift-b : set a bookark at the current guide star position (the "lock position") 

 Ctrl-b : clear all bookmarks  

 Ctrl-click somewhere on the image: set a bookmark at that position, or remove the bookmark 

that's already there 

By setting a bookmark before you make a mount adjustment, you can get a clear view of how the 

adjustment has moved the star on the guide frame. 

 

Next, click on the 'Altitude' button.  Then slew the scope to a position near the celestial equator and 25-

30 degrees above the horizon.  Click on the 'drift' button to begin collecting data for the altitude part of 

the alignment process.  As before, you will iterate between making adjustments and measuring your 

alignment until you are satisfied with the result, keeping notes as you go about how mount adjustments 

affect the behavior of the declination drift line.  If you make substantial adjustments in altitude, you'll 

need to go back to the 'azimuth' measurement and repeat that procedure.  If you work through these 

procedures systematically, you'll converge on a good polar alignment with a known degree of 

accuracy.  A good polar alignment will help your guiding performance, especially in declination. 

 

The drift alignment tool is easiest to use when you are using an ASCOM connection to your mount 

(including an 'Aux' connection).  Even if you subsequently want to use ST-4 style guiding, you should 

use the ASCOM connection for drift alignment.  If you can't do that for some reason, the following 

features will be impaired: 

 Scope position data and slewing functions will not be available - you'll have to slew the scope 

yourself 

 The magenta circle that identifies the target for moving the star will be inaccurate and will be 

displayed as a dashed line.  This dashed circle will identify only an upper bound to the 

adjustment, so you will probably want to make smaller adjustments to avoid over-shooting. 

A very complete step-by-step tutorial for drift alignment is available on the Openphdguiding web site, 

and first-time users are strongly encouraged to study it. 

(https://sites.google.com/site/openphdguiding/phd2-drift-alignment) 

Lock Positions 

PHD2 normally sets a 'lock position' where the guide star is located at the end of calibration.  Depending 

on the details of the calibration sequence, this may not be exactly where the star was located at the start 
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of calibration - it could be off by a few pixels.  If you are trying to precisely center your target, you may 

want to use a 'sticky lock position.'  You do this by clicking on your guide star before calibration, then 

setting the 'Sticky Lock Position' under the 'Tools' menu.  After calibration is complete, PHD2 will 

continue to move the mount until the star is located at the sticky lock position.  So you may see an 

additional delay after the calibration while PHD2 repositions the scope at guide speed.  The sticky lock 

position will continue to be used even as guiding is stopped and subsequently resumed.  Again, this 

insures a rigorous positioning of the guide star (and presumably your image target) at the expense of 

delays needed for PHD2 to reposition the mount.  

Comet Tracking 

One way to image a comet is to have PHD2 use the comet as the guide "star", but this approach may not 

always work. For example, the head of the comet may not present a star-like center suitable for guiding. 

Or, when using an off-axis guider, the comet may not even be visible in the guide camera. 

 

PHD2 provides a Comet Tracking tool for use when guiding on the comet itself is not feasible. The idea 

is to guide on an ordinary star, but to gradually shift the lock position to match the comet's motion, or 

tracking rate. 

 

There are a three different ways to provide the comet tracking rate to PHD2. 

 Some planetarium applications, like Cartes du Ciel, can send the rate directly to PHD2; 

 You can enter the tracking rate manually, or, 

 You can train the rate in PHD2 by following the comet for a period of time in the imaging 

camera. 
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To enter the rate manually, you would select "Arcsec/hr" for units and "RA/Dec" for axes, then enter the 

rates from the comet's ephemeris. 

 

Comet rate training works like this: 

 

First, center the comet in your imaging camera. If your imaging application has some kind of reticle 

display, you should use that to note the precise position of the comet on the imaging sensor. Once this is 

ready, select a guide star in PHD2 and start guiding. Next click "Start" in the Comet Tracking tool to 

begin training. 

 

Take a continuous series of short exposures in your imaging camera using your imaging application's 

Frame and Focus feature. Over time, the comet will drift away from the starting location. Use PHD2's 

"Adjust Lock Position" controls to move the comet back to the starting location. You may have to 

experiment a bit to determine which way the comet moves on the imaging camera sensor in response to 

the Up/Down/Left/Right controls in PHD2. You may find it useful to enable the "Always on top" button 

in the Adjust Lock Position window so the controls stay visible on top of your imaging application. 

 

PHD2 will quickly learn the comet tracking rate as you re-center the comet. Once you are satisfied that 

PHD2 is tracking the comet, you can click Stop to end the training. PHD2 will continue shifting the lock 

position to track the comet until you disable comet tracking by toggling the Enable/Disable button. 

 

You can practice the comet training technique using the built-in camera simulator. Check the "Comet" 

option in the Cam Dialog, and the simulator will display a comet. Use a bookmark to mark the comet's 

starting location, and use the Adjust Lock Position controls to move the comet back to the bookmark 

location.  

Managing Equipment Profiles 

Equipment profiles were introduced in the section on Basic Use where they are used as part of the 

'Connect Equipment' dialog.  If you want to manage multiple profiles, you will probably want to use the 

'Manage Profiles' button in the 'Connect Equipment' dialog.  Using the menu items there, you can create 

a new profile or edit/rename/delete an existing one.  Each profile holds all the settings that were active at 

the time the profile was last used.  If you create a new profile, you can import these settings from either 

the PHD2 generic defaults or from an existing profile.  You can also use the 'Wizard' option to have 

PHD2 establish settings that are specific to your equipment configuration.  To edit the settings in an 

existing profile, you first select it in the equipment profile drop-down list, then click on 'Settings' under 

the 'Manage Profiles' pull-down.  This will take you to the 'Brain' dialog, where you can make whatever 

changes you want.  Remember than profiles are automatically updated anytime settings are changed 

during a PHD2 session.  Finally, you can import and export profiles for purposes of debugging, backup, 

or even exchange with other PHD2 users. 

Advanced Settings for the Simulators 

The device simulators were introduced in the Basic Use section as useful tools for you to experiment 

with PHD2 and become famliar with its features.  Remember that you must choose 'Simulator' as the 

camera type and 'On-camera' as the mount type in order to get the benefits of simulation.  As you 

become more interested in the details of the simulation, you can use the 'Cam Dialog' button on the main 

display to adjust the simulation parameters: 

http://openphdguiding.org/man-dev/Basic_use.htm
http://openphdguiding.org/man-dev/Basic_use.htm
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You can adjust simulated mount behaviors for declination backlash, drift due to polar mis-alignment, 

and periodic error.  You can also adjust the 'seeing' level, which will create fairly realistic guide star 

deflections that look like seeing effects.  If you adjust these parameters one-by-one, you'll see how they 

affect star deflections and how the different guide algorithms react to those movements.  Of course, 

you're dealing with a "nearly perfect" mount in these scenarios (except for backlash), so the simulation 

can't be entirely realistic.   
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Table of PHD2 keyboard shortcuts 

Shortcut Function 

F1 Help 

Ctrl-C Open Connect equipment window 

Shift-Ctrl-C Connect all equipment 

Ctrl-L Loop 

Alt-S Auto-select Star 

Ctrl-G Guide 

Ctrl-S Stop 

Ctrl-D Dismiss alert 

Alt-C Review calibration 

Ctrl-O Clear calibration (force re-calibration) 

Ctrl-A Open Advanced settings 

B Toggle Bookmarks shown/hidden 

Ctrl-B Delete all Bookmarks 

Shift-B Bookmark lock position 

Alt-L Toggle Guide Log enabled/disabled 

Shift-Ctrl-M Enter Manual calibration 

Trouble-shooting and Analysis 

Calibration and "First Use" Problems 

If you are just starting to use PHD2 or are connecting to new equipment for the first time, you may have 

trouble getting the guider calibration done.  This problem usually takes one of two forms, each requiring 

different responses:  

1. The star moves during calibration but it moves "too far" or "too little."  This is easy to fix - 

simply adjust the 'calibration step-size' parameter in the 'Mount' tab of Advanced Settings. The 

help content there describes how this parameter is used, and you should be able to resolve the 

problem quickly. 

2. The star doesn't move at all or it moves only very small amounts and in unpredictable 

ways.  Actually, the small movements in this scenario are often the result of seeing deflections 

and the mount isn't really moving at all.  Dealing with this sort of problem is described next. 

In nearly all cases, the "no movement" problem is caused by failures in the hardware or, even more 

likely, problems in the cabling and connections.  The best tool for trouble-shooting this is the 'Manual 

Guide' option under the 'Tools' menu, as described in the Tools section of this help document.  Simply 

use the directional controls in the 'Manual Guide' window to send commands directly to the mount.  If 

the mount does not respond, you know you have either hardware or connectivity problems to resolve - 

nothing to do with PHD2.  If you're using a Shoestring device to connect to the mount, watch its 

indicator lights to see if the commands are reaching it.  Similarly, your ST-4 compatible guide camera 

may have indicator lights to show when guide commands are being received.  If you're using an 

ASCOM connection to the mount, be sure the COM port assignments are correct.  You can also use 

http://openphdguiding.org/man-dev/Advanced_settings.htm
http://openphdguiding.org/man-dev/Tools.htm
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some of the ASCOM-supplied tools like POTH to be sure the ASCOM driver is communicating 

correctly with the mount. 

 

Calibration Sanity-Checks 
It is also possible that the calibration process will complete but PHD2 will post a "calibration sanity-

check" alert message saying that some of the results are questionable.  This "sanity check" dialog will 

show an explanation of the issue and some details of the calibration results:  

 

 

 

In the initial release (2.4.0), there are four things checked by PHD2:  

 Too few steps (shown above) - resolving this issue is quite easy.  Just adjust the calibration step-

size downward until you get at least 8 steps in both the west and north calibrations.   

 Non-orthogonal camera axes - the camera axes are normally computed independently even 

though they should be perpendicular.  The angle calculations do not require great precision, but 

if they are signfiicantly non-orthogonal, you should repeat the calibration.  Alternatively, you can 

set the option to'Assume Dec orthogonal to RA' in the 'Mount' tab of the Advanced Setup dialog. 

The graph at the left shows the RA and Dec axis orientation as measured by PHD2..    

 Suspicious RA and Dec rates - the guide rate for right ascension should be related to the 

declination guiding rate by approximately a factor of cosine(Declination).  In other words, the 

RA rate gets smaller as you move the scope further away from the celestial equator (Dec=0).  In 

this initial release, PHD2 won't try to identify which rate is incorrect - it is simply alerting you 

that something looks wrong with the rates.  You can sanity check these rates yourself quite 

simply.  If you are guiding at 1X sidereal rate, your declination guide rate should be 

approximately 15 arc-sec/sec; with a guide rate of 0.5X sidereal, the declination rate would be 

7.5 arc-sec/sec, etc. 

 Inconsistent results - if the calibration results are significantly different from your last-used 

calibration, an alert message will be generated.  This may happen because you've made a change 

in your configuration.  That doesn't imply a real problem, but you should probably consider 
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creating a separate profile for the new configuration.  By doing so,  PHD2 will remember 

settings for each of your profiles, letting you switch between them easily.  If you haven't made a 

configuration change, you will probably want to determine why the results are so different. 

With any of these alerts, the relevant data field will be highlighted based on the type of message.  You 

can choose to ignore the warning ('Accept calibration'), re-run the calibration ('Discard calibration'), or 

restore your last good calibration ('Restore old calibration').  With the third option, you can defer 

calibration until later and start guiding with your last good calibration data.  If you see repeated alerts on 

the same topic and are convinced there really isn't a problem, you can use the 'don't show' checkbox to 

block future alerts of that type.  

Program "Hangs" and Camera Download Problems 

In some cases, you may experience problems where guider images aren't downloaded or displayed.  In 

extreme cases, this may even cause PHD2 or other camera-related applications to be non-responsive (i.e. 

to "hang").  Again, this is almost always due to hardware, camera driver, or connectivity issues, with one 

of the most common culprits being a faulty USB cable or device.  It is highly unlikely to be caused by an 

application like PHD2, so you should begin your investigation at the lower levels of the system. You 

can start by confirming that the guide camera is working - try using a short, direct cable from the camera 

to the computer and taking exposures with the "native" or test application that came with the camera.  If 

the camera is functional, you can start moving "upstream" by looking at USB hubs and cables, swapping 

them one at a time to see if you can isolate the problem.  It's worth remembering that we work in 

a hostile environment while doing our imaging, and many of the components we use are not designed 

for cold, outdoor conditions. So something that worked just last week or last month may no longer be 

reliable. 

Poor Guiding Performance 

Once you've gotten everything running, you will probably get reasonably good guiding results almost 

immediately.  You will have to decide what "good enough" means, and everyone's standard is likely to 

be different.  But if you find your imaging results are not acceptable because the stars are streaked or 

elongated, you'll need to take a systematic approach to correcting the problems.  This can be a complex 

task and not something to be covered here.  However, you can get help on the web from a variety of 

sources, with the document by Craig Stark being one of the best:   

http://www.cloudynights.com/page/articles/cat/fishing-for-photons/what-to-do-when-phd-guiding-

isnt-push-here-dummy-r2677. 

Log Analysis 

Any sort of problem isolation or tuning will invariably require use of the PHD2 log files.  Both are 

formatted for straightforward interpretation by a human reader, and the guide log is constructed to 

enable easy import into other applications.  As mentioned in the 'Advanced Settings' section, 

applications such as PHDLab or Excel can be used to visualize overall performance, compute 

performance statistics, and scrutinize time periods when guiding was problematic.  With Excel or similar 

applications, simply specify that the guide log uses a comma as a column separator. 
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Guiding Log Contents 

The contents of the guiding log will continue to evolve as new capabilities are added.  But the basic 

content is stable, and considerable care is taken to not "break" applications that parse it.  If you wish to 

analyze the log yourself, the following information will be helpful.   

The PHD2 guide log will contain zero or more sequences of calibration and zero or more sequences of 

guiding.  Each of these sections has a header that provides most of the information about the guiding 

algorithms being used and the internal parameters used by PHD2 for guiding.  At the start of either a 

calibration run or a guiding sequence, the last line of the header information defines a set of column 

headings.   The meanings of those columns are shown below: 

 Calibration columns: 

 dx, dy  are offsets from the starting position, in pixels, in the camera coordinate system 

 x, y are the camera x/y coordinates of the guide star at the end of each calibration step 

 Dist is the total distance moved in the camera coordinate system (dist = sqrt(dx*dx + 

dy*dy).  This is the value used by PHD2 to compute the calibration parameters 

 Guiding columns:  

 dx, dy are the same as for calibration - offsets from the "lock position" of the guide star in the 

camera coordinate system 

  RARawDistance and DECRawDistance - these are the transforms of dx and dy into the mount 

coordinates - in other words, they use the arbitrary angle of the guide camera to map from X/Y 

on the camera to RA/Dec on the mount 

  RAGuideDistance and DECGuideDistance - these are the outputs from the various guiding 

algorithms.  The guide algorithms operate on the "raw" distances and decide how far, if any, the 

telescope position should be adjusted in each axis.  For example, with a "minimum move" 

parameter set, the "guide" distances can be zero even when the "raw" distances are non-zero. 

 RADuration, RADirection, DECDuration, DECDirection - these are the values determined by 

the two "guide" distances above.  The "durations" are the lengths of the guide pulses, in 

milliseconds, needed to move the mount by the distances specified by RAGuideDistance and 

DECGuideDistance 

 XStep, YStep - step-adjustment durations for the adaptive optics device if one is being used 

 StarMass - a brightness measure of the guide star image 

 SNR - an internal "signal-to-noise" ratio used by PHD2 

 ErrorCode - an indication that some error occurred, typically a "guide star faded" error 

All distance values are in units of pixels.  The header for the guiding section will show the image scale 

as it is known by PHD2, and that can be used to scale the pixel distance values into units of arc-seconds 

if desired. 

Problem Reporting 

If you encounter application problems that are specific to PHD2, you are encouraged to report them to 

the open-phd-guiding Google group: https://groups.google.com/forum/?fromgroups=#!forum/open-

phd-guiding.  Obviously, the more information you can provide, the more likely we will be able to 

resolve the problem.  Using the following guidelines will help in that regard:  
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1. Try to reproduce the problem - if we have a clear set of steps to follow, we are more likely to 

find a solution quickly.  If you can reproduce it, try to reduce things to the minimum number of 

steps.  Remember, we won't have your hardware or computer environment when we try to 

reproduce it ourselves. 

2. Try to be complete about describing your configuration - operating system, equipment types, 

PHD2 version, etc. 

3. Attach the PHD2 debug log from the session in which you encountered the problem.  You can 

find the debug log in the PHD2 folder in your Documents folder. If you can't reproduce the 

problem, try to estimate the time of day when you first saw it - this could help us find evidence 

in the debug log without having to sift through hundreds of lines of output. 

 

   


